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Welcome! 
If you are reading this document in Acrobat (PDF) format, we suggest you to open the bookmarks in a sepa-
rate window. Just click the icon as indicated to do so, if relevant:  

 

 

 

 

 

 

You can navigate through the different parts of this manual by clicking the desired part in the left window.  

If you cannot read PDF-files, you need some software (Acrobat reader). You can download it free on this 
site:  http://www.adobe.com/products/acrobat/readstep2.html 

 

To get more help on the CCT application, read chapter 14: help 

 

 

 

http://www.adobe.com/products/acrobat/readstep2.html
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1 Preface 
CCT (Communications and Controlling Tool) is an application joining the partners of the European 
project EQUAL, TCA 866 together by the Internet. Participants can be organised in groups. Several pass-
word-controlled accesses are possible, with specific competences. This software offers several modules, 
each accessible by clicking these tabs: 

 

Calendar: Can be accessed by different groups and persons 

Contacts: With the possibility to import, data from popular applications as Outlook (express) 

Forum: With erase possibilities for each participant  

Files (up and download) 

Projects: With filter possibilities, statistics and timeline 

Timecard: Making it easy to administer budgets 

Notes 

RTS (Request Tracking System) with a knowledge base linked 

Mail: Attachments and listing made possible 

Options: To adapt settings of the application 

? (Help): More explanations for newbies 

© Copyright: credits to who deserves 

>>: quit the application 

Admin: Administrators only. Possibility to create users and change settings.  
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2 Starting, Closing 
Before starting the application, make sure that you are connected to the Internet. Your login and password, 
which your administrator gave you, are requested. Make sure you are not mixing upper and lower case: 
John, john, JohN and jOHN are different passwords. 

 

Click on the tab “Options” in the menu 
bar if you want to change your pass-
word. Watch the limitations of charac-
ters, as specified in the form. Click on 
the little arrow down left when you are 
done.  
Always change your password after 
your first login. 

  

 

 

If you succeeded to log in, the system brings you to the calendar page. Remark the horizontal bar with tabs 
at the top of it. This bar is the menu system of CCT. Each tab opens a menu page with forms and data. 

Just click the Close tab to close the application. All your data are stored on a central computer. That 
way you can access them from every location that connected to the Internet. After logging out, you 
will see the login screen again, with a multilingual goodbye message.  
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3 GUI (Graphical User Interface) 
After you logged in successfully, the calendar page opens. A small pop-up window will remind your appoint-
ments of the day.  

 

At the top of the application window, remark the address field of your browser. The URL to reach the appli-
cation is 

http://www.syntra-ab.be/equal/cct/index.php 

Newbies can try out the application without harm on the address  

http://www.syntra-ab.be/equal/project/index.php 
 

At the far right of the menu bar, at the right of the Close tab, you will see to which group 
your login belongs (SYNTR in this example). If you are member of several groups, you can 
select another group by clicking the arrow . If you are an administrator, you will see the 
Admin tab, which others will not see.  
 
 

The system distinguishes competences as follows: 
• Users are able to view events from other group members, but not the text of those events  
• Chefs are able to write events into other calendars, additionally they can create statistics and pro-

jects 
• Administrators have access to the admin section. They can create new users, change passwords, 

etc. Administrators have all those rights only in the group to which they belong.  
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4 Calendar 
After your login, the system automatically shows up the Calendar window. If you are in another part of the 
application, just click the tab Calendar to get there. 

 

Remark the three vertical panels of the calendar: 

• The left panel consist of the calendar and a form to create single events. The results pop up in the 
middle pane. 

• The middle pane lists the events of the day. You can view them individually or as a group view. 

• Several utilities are grouped in the right pane: 

o RTS requests dedicated to you 

o Your TODO-list 

o Notes 

o Bookmarks 

o Projects 

o Pending votes 

 

4.1 The left Calendar pane 

4.1.1 Booking your activities on the timecard.   

Above the calendar, you will find a button bar commanding the timecard. The first red button registers your 
starting time; the last red button registers your ending time. Register your breaks and interruptions with the 
blue buttons. Check the name of the buttons by hovering them.  

You can make the registrations in the timecard itself. Click on the tab Timecard of the menu bar to reach the 
form.  
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4.1.1.1 Registering the start of your activities (red button at the left). 

Click the first red button to open the registering 
form, then click the Submit button to register 
your begin time in your timecard.  

To check registered times, click the tab Timecard 
of the menu bar.  

Use the hyperlinks “Print” or “export CSV-list” to 
make a paper copy of your data, or to create a 
CSV file in order to export your data in e.g. a 
spreadsheet. 

 

 

 

 

 

4.1.1.2 Registering breaks and interruptions (blue buttons) 
Click the left blue button to pause the registration 
of your working time until you click the second 
blue button. You can use this buttons for breaks, 
interruptions or Out of Offices. You only can 
interrupt your work once a day.  
 
To see the results of your clicking, open the 
timecard by clicking Timecard tab in the menu 
bar. 

Do not forget to click the submit button to 
confirm your action. 

 

 

4.1.1.3 Booking your end of activities (red button at the right) 
You can register your end of activities by clicking 
the right red button above your calendar. Do not 
forget to click the submit button to confirm your 
action. 

To see the results of your clicking, open the time-
card by clicking Timecard tab in the menu bar. 

You cannot give more than one begin or end 
time. Use the blue buttons to indicate breaks or 
interruptions in your working time 
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4.1.2 Calendar 

Within de calendar, which opens in the current month, you will find the day 
of the month of your computer clock indicated in red. Month and year are in 
the utmost line, left and right of it arrows to go up and down the row of 

months. Always confirm changes with the return arrow ( ).  

You will find the week numbers left of Monday. Week 1 is the week with the 
first labour day of the year in it.  
 
 

4.1.2.1 Resource list 
By clicking the hyperlink “Resource List”, you get the list of resources, booked for the indicated day. If you 
would like to see the complete list of booked resources, click the tab Options in the menu bar, and there List 
of Resources. Confirm by clicking the button View. 

You can book resources while creating an appointed in the extended mode. Only administrators can create 
resources. 

4.1.2.2 Event List 
By clicking the hyperlink “Event List”, the application opens in the middle panel the list of pending events of 
the logged person. 

With the Search function, you can indicate a 
word in text, note or remark to retrieve some 
events. 

By checking the checkbox “Entire List”, you will 
get all the passed appointments as well. Con-

firm your action with the return button ( ). 

The red quadrangle in front of de date indi-
cates that you can delete this event. Click on it 
to do so. 

By clicking the +sign behind Group View, you can view several calen-
dars of persons of your group. To view the list of calendars belonging 
to other groups, change the group in list box situated in the upper 
right corner of the application window.  

You can select a profile of calendars in order to remember the list of calendars you often want to show up. 
Create profiles in the module Options, which you reach by clicking the Option tab in the menu bar. 

With the time axis and the time interval, you can manipulate the way you want to view these calendars. 

View the grouped calendars in the middle pane. They only include the current month. You can change this 
month by changing the date in the calendar itself. 
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4.1.3 Create and delete events. 

In order to create an event the quick way, use the form in the left 
pane of the Calendar page. Check the date in the upper form (calen-
dar), and fill in the fields “From:” and “Until:” in the format HHMM, 
without any sign between the figures. Then fill in the field “Text:”, 
which will show up in the event list. Optionally you can add some 
comments, e.g. the location where the event occurs or the agenda of 
a meeting. Confirm your action with the Create button. 

If you want more data for your event, click 
the hyperlink “Extended” to open an 
enlarged form in the middle pane. You have 
the same possibilities as in the quick win-
dow, plus this features: 

• Visibility: normal, Personal (only 
you), or Public 

• Resource: you can select one only. 

• Contact: you can select one only. 

• Project: you can select one only. 

• Remark 

• Multiple events: once, daily, weekly, 
monthly or yearly with or without 
end date. 

Do not forget to confirm your entries with the Create button. Click the Delete button to delete. 

 

4.1.4 Searching 
In order to find events, type the string to search on. Next, select the modules to search in. Do not forget to 

confirm your action with the return ( ). 

The results list contains a hyperlink for each found event. Just click on it to view it. 
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4.2 Middle pane of Calendar 
This pane shows the data you asked for. In the utmost line, you will find the date, the name of the logged 
person and the name of his/her organisation. 

In order to create a new event, just click on the de-
sired hour, after checking the date. Click on the hy-
perlink “Extended” in the left pane if you want to put 
in detailed information. 

At the bottom left, remark the hyperlink “Print”. By 
clicking it, you will get a paper copy of the visible 
page. 

To edit an event, click on the blue text of it. The 
event appears in the middle pane. Choose for clicking 
on the Modify button to register your changes, on the 
Delete button to delete this event.  

Click on the hyperlink “Back” to return to the former 
view of the events. 

 

 

 

4.3 Right pane of Calendar 
The pane of the Calendar page groups several utilities, listed in this table: 

RTS (Request Tracking System): list of requests addressed to you. Click 
the hyperlink “List” for more details. Confirm with the Return button.  

TODO-list: list of your to-dos imposed by yourself or imposed by members of 
your group. Create a to-do for yourself or for a member of your group by 
choosing a name code from the list box and typing in the field box at the left of 
this list. Click the Return button to confirm. The red quadrangle indicates that 
you can delete this to-do. Just click on it to do so. 

Notes: List of the notes that you created.  

Bookmarks: list of your URL links. Click on “New” to create a new one, 
or click on “List” to see the complete list. Confirm with Return button. 

Projects: list of projects in which you are involved, created with chief 
status. Click the hyperlink “List” to see more details. 

Votes: Not yet responded votes. Click the hyperlink “List” to see the 
result of this voting. 

Answer the vote by clicking near your choice. If several alternatives are 
permitted, hold the CTRL-key down while clicking. Do not forget to 
confirm your action by clicking the return button. 
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Look for more explanations of these utilities:  

RTS (Request Tracking System) 

 Notes 

Bookmarks 

 Projects 

 

 

EQUAL TCA 866. Secretariat: Syntra-AB, Mechelen Belgium. 29/10/2002, Page 10 of 10 



CCT for Equal: user’s manual  
E-Adaptation for Business & Learning: Communication & Controlling Tool 
________________________________________________________________________ 

5 Contacts 
View the Contacts page by clicking the Contact tab of the 
menu bar. Contacts are dived in two groups: “Group Mem-
bers” and “External Contacts”. You cannot see them both at 
once.  

Only the administrator of a group can create members of that group. Create External Contacts by clicking 
the hyperlink “New”. This opens the New Contact form:  

ve from one field to the other, use TAB, to move backwards, use SHIFT + TAB. Do not use the return 

.  

lt is unmarked. 

ormation in the Comment box. Put some keywords in this box, which can facilitate your 
search operations. 

 
To mo
key. 

By dedicating some contacts to a category (e.g. “Partners”), you can later filter this category for searching

Mark the checkbox “Open to all”, if you would like the others to see this contact. De defau

To create your new contact, click the Create button, to delete it, click the Delete button.  

You can put any inf
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5.1.1 Importing Contacts 
You will probably own electronic lists of contacts in vCard, Outlook, Outlook Express or in some other for-
mat. You can import these by making an export file in the original application (e.g. Outlook) in CSV format 
(Comma Separated Value). Use the Windows variant if asked 

Maybe you will have to adjust the fields. Your CSV-file should contain these fields, in the same order:  

title, first name, family name, company, email, email 2, phone 1, phone 2, fax, mobile 
phone, street, zip code, city, country, state, category, remark, web address.  

Make empty columns (in a spreadsheet like Excel) for the fields you do not have in your contacts  

Import the CSV-file in CCT. Choose 
“Import” on the Contacts module, and 
indicate the original application where 
your data comes from.  
Indicate where the CSV-file can be 
found.  

Eventually indicate a category to filter 
on. 

Check the checkbox “Open to All” if 
you want these contacts to be visible 
for others.  

After a successful import, you should 
get something like this: 

 

 

A small green quadrangle indicates a personal contact, invisible to others. 

A small blue quadrangle hides the second phone number, the mobile number and second mail address if 
any. Just hold the mouse indicator over the quadrangle to see these data (hoover).  

The name is a hyperlink to the form. If you are the creator of it, you can edit it to modify or delete it.  

To open the mail module, just click on a mail address in the contacts. A new mail form is opened, with your 
contact as addressee. 

You can find a contact by choosing a field for the search operation. Do not forget to confirm your action by 

clicking the return button ( ). 
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6 Forum 
To open the Forum page, just click the Forum tab in the menu bar. You can only watch the Forum which is 
dedicated to your own group. If you are member of several groups, first change of group in the list at the 
right of the menu bar, and open Forum afterwards.  

In the upper line, you can filter contributions to the forum on text or name of the contributor. 

 

The title of the contribution is a hyperlink. Just click on it to open the whole contribution. 

At the bottom, the hyperlinks “Print” and “Back” are just doing what they suggest: print out the contribution 
or bring you back from where you came from.  

To contribute as an answer to an existing one, just type your text in the white box and click the Post button. 
Your contribution will be preceded by "RE: " (Return) and show indented forming a thread.  

 

7 Files (archives) 
You will find the File page by clicking the File tab in the menu bar. From there on you can upload or 
download files to the system. 

 

The meaning of the coloured quadrangles is as follows:  

• Red indicates that you can delete this file from the server;  

• Blue indicates that you are allowed to make changes; 

• Green indicates that this file is for your eyes only (personal) 

Just click on the coloured quadrangle to activate it. Hoover on it to see its meaning. 
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After clicking the "New" hyperlink, you open the form File Management. 

Enter the filename 
and path to the file 
you want to copy 
to the server, or 
activate the button 
at the right of it to 
search for it.  

You can encrypt 
the file with a 
password, which is 
needed in order to 
be able to read or 
download it from 
the server. 

Indicate a new 
category in the 
field Category, or 
indicate an existing 
one in the field at 
the right of it. 

Make your choice for the access possibilities. Choose the "Me" check box if you want it Personal, "All" if you 
want everybody to be able to view the file (and download it). Choose a profile if you want a group to see it. 
Choose "Some" to indicate manually (by holding the CTRL-key) the persons allowed to view and to 
download your file. 

The text you type in the Comment box will be repeated in the File page. 

Finally click the Go button if you are satisfied with your choices and the Back button if you are not.  
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8 Projects 
To open the Project page, just click the Project tab in the menu bar. Projects are linked to timecards. That 
way you can dedicate the working time of persons or budgets to projects. Only administrators and chiefs can 
create and edit projects. Only the projects of the group linked to the login can be viewed. 

In the upper line, to select projects for searching with or without their subprojects, click the radio button 
“Open” or “Closed”. You can also filter on fields and categories.  

In order to view the subprojects from the list, just click the + sign, close by clicking the minus sign.  

 

To open a project, click on the hyperlink with its name. If you cannot you are not allowed. Project assistants 
and visitors only can view the title and some data 

 

Watch your dates: they should be in the format YYYY-MM-DD in order to get a chronological listing.  

From this form, you can create subprojects by clicking the hyperlink “New Project”. You can create Notes by 
clicking the hyperlink “Notes” and print the data by clicking “Print”. Click on “Back” if you do not want the 
system to keep your changes.  

EQUAL TCA 866. Secretariat: Syntra-AB, Mechelen Belgium. 29/10/2002, Page 15 of 15 



CCT for Equal: user’s manual  
E-Adaptation for Business & Learning: Communication & Controlling Tool 
________________________________________________________________________ 

 

8.1 Creating a project 
You need to be an Administrator or Chief in 
order to be able to create projects. If you have 
this status for several groups, first indicate in 
which group you want to create a project. Just 
choose the group from the list box at the right 
of the menu bar.  
 
 

 
To create a new project, just click the “New” hyperlink at the left. The Project form opens. 

In the field “Name of the Project”, the name you will type will be shown in the list as a hyperlink. 

With the content of the field Category, you will be able to make selec-
tions in your search options. If you do not want a category for this 
project, leave the list box empty. 

 

 

 

Watch the date format in the “Begin” and “End” fields: they should be formatted as YYYY-MM-DD. The sys-
tem will control your input. 

You can indicate whether this project is part of another project, by filling in the field “Subproject of”.  

The Leader of the project is not necessarily Administrator or Chief, but (s)he must be member of the group. 
To make a new group member, you should be Administrator.  

The hourly rate is expressed in Euros. So is the budget. You cannot change this, even not with the settings 
in the configuration of your computer. 

You can specify the priority of the project in nine degrees.  

Indicate at the right who is participating in the project. Only group members can be selected. If your project 
is important, you can ask your administrator to create a group for the project. In order to select several 
participants, hold down the CTRL key when clicking. 
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8.2 Project Statistics 
In order to follow up projects, you can view sta-
tistics by clicking the “Statistics” hyperlink in the 
Project page.  

In the left pane of the Statistics window, you can 
select projects per person and per dates. Confirm 

your action by clicking the return button ( ).  

 

The result is shown in the right pane: 

 

 

 

 

 

 

8.3 Timeline of Projects 
In order to view a simplified Gantt chart of (a selection of) the project you are involved in, click the “Time-
line” hyperlink in de Project page, which you access by clicking the Project tab in the menu bar.  

In the up most line, you can indicate the period of the timeline expressed in months. You can also select 

whether or not you want to see the subprojects. Confirm your choice by clicking the return button ( ). 
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9 Timecard 
To view and edit timecards, click on the Timecard tab in the menu bar. Here you can register times after-
wards. To register time “on the spot”, see Calendar.  

The Timecard window presents as follows: 

 

You can enter records afterwards, but notice that your chief will get a copy by mail. 

To assign your time to projects, just fill in the amount of hours and minutes per project. Within the Project 
window (statistics), you can check the total amount, or the amount of time per person. 

You can export these figures to a CSV file. Most spreadsheets can import this file. Click on “Export CSV list” 
either for exporting the timecard or the bookings. 

If you want a detailed view of your time, just mark the checkbox “Show Bookings” in the up most line. Con-

firm your action with the return button ( ) 
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9.1 Deleting a time record 
 

Only the time records followed by a red quadrangle can be deleted. Just click on it to do so. Confirm in the 
pop up window. 

To edit a record in order to change them, you should first delete and create a new one. Your chief will get a 
notice of this changes by mail. 

9.1.1 Create a new time record after date 
Use the Calendar to record your times. See Calendar.  
If you want to record times on another day, you have to pass through the Timecard page, which you access 
by clicking the timecard tab on the menu bar. Choose the right day, and eventually correct the month in the 

right pane. Bring in begin- and end break times one by one, followed by a click on the return button (  ). 
Your chief will be assigned of your changes by mail. 

You should fill in the time as XXXX without “:” be-
tween the figures. Confirm with the return button. 
 
 
 
 
 
 
 
 

 

9.1.2 Assigning time to projects 
De timecard sums the time passed per day. If you want to split up this time on one or more projects, use 
the left pane of the timecard. 
 

Select the day under “Assigning Projects” 

and confirm with the return button ( ). 

Select per project the time in hours and 
minutes, and click the return button to 
confirm. You only can see the projects in 
which you are involved on the selected 
day.  

By assigning too much time, the unas-
signed time turns into red.  

 

If you checked “Show Bookings” in the up most line, our example turns as follows: 
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10 Notes 
To open the Notes page, click the Notes tab in the menu bar. Consider notes as appendixes of projects and 
contacts in most of the cases, or as stand-alone documents. 

The “Open to All” notes can be viewed in the right pane of the calendar. You cannot create notes in the 
calendar.  

Contact Notes or Project Notes are situated in their respective pages, with the possibility to create them 
there as well. 

 

De Notes page is vertically divided in two panes. The left pane to edit Title and text, the right one to list 
them.  

Notes can be public or personal. Public means: all the members of the group to which the login belongs. 

Personal notes are marked with a green quadrangle. 

A red quadrangle indicates the possibility to delete this note. You only can delete your own notes, the red 
sings thus marks all your own notes. 

When hovering the blue quadrangle, you should be able to read the first words of the hovered note.  

To open a note, just click on the title of it. 
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10.1 Creating a Contact Note 
In order to create a contact note, first open the Contact page by clicking the Contact tab in the menu bar. 

Click name of the contact on which you wish to link the new note. The contact form is opened.  

In the Contact form, click 
the hyperlink “Notes - 
Create”. The Notes form 
is opened and linked to 
the contact you indi-
cated.  

Make your note and 
confirm your action with 
the return button. 

You also can start in the 
Notes page, and indicate 
the contact in the lower 
left corner. 

The new note will be 
listed as first in the 
Notes list. 

 

 

 

 

 

 

 

 

 

By opening the contact on which the note is linked, you will 
remark the list of notes linked to that contact. You can open 
the note from there by clicking the title. 
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10.2 Creating a Project Note 
 
In order to create a project note, first open the Project page by clicking the Project tab in the menu bar. 

Click name of the project on which you wish to link the new note. The project form is opened.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
In the project form, click the hyperlink “Notes - Create”. The Notes form is opened and linked to the project 

and confirm your action with the return button. 

 the lower left corner. Confirm your action 

you indicated.  

Make your note 

You also can start in the Notes page, and indicate the project in

with the return button ( ) 

 

 

The new note will be listed first in the Notes list. 
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10.3 Creating a new Note in the Notes page. 
Notes can be created in the Notes page as well. To access the Notes page, click on the Notes tab in the 
menu bar.  

 

The title will be listed as hyperlink at the right. If you want to link your note to a contact and/or a project, 
make your choice in the list boxes under the input box under the title. 

As you will be able to perform search actions on the text in the input box, put some keywords or references 
in it in order to facilitate your later searches. 

The list boxes Contact and Project only admit one and only selection each. The Project list boxes lists pro-
jects and subprojects. 

By marking the checkbox “Open to all”, you make this note public to the members of your group. By leaving 
it unmarked, your note is marked green (Personal), and is invisible for other users of the system.  

Confirm your action with the return button ( ) 
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11 RTS (Request Tracking System) 
The Request Tracking System, also called ‘'trouble ticket system', helps the users to get out of trouble. It also 
helps the administrators to get grip on the failures of the system  

Everybody can use RTS to ask questions, consult data, make remarks and give answers. 

11.1 Opening a request in RTS 
To open the RTS page just click the tab RTS in the menu bar. The page opens with a list of pending ques-
tions:  

 
To open a request, just click the number at the left of it. These are unique identification numbers, which are 
communicated by mail to the creator of the request.  

In the status column you can see in which faze the request belongs.  

De column Ass. (Assigned to) shows the code of the person to whom the request is directed by its creation. 
This can be updated later on. This person will see the request in his calendar (right pane 

How the form shows up, depends of who opened it: the assigned or another person: 

Opened by not-assigned person: 
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Opened by assigned person: 

 
 

Everybody can give comments on a RTS, only the assign person can answer it. However, the assigned per-
son can be changed by the originally assigned person. 
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11.2 Creating a RTS 
The right place to start the creation of a RTS is the RTS tab in the menu bar.  

Click on the Hyperlink “New Request” in the up most left corner to open the Request form: 

 

 
 
Check the indicated mail address. The answer of your request will be sent to that address.  

Above the form, the button “Show Queue” offers the possibility to view the pending requests.  

Be as specific as possible when typing the title as later on searches can be made on it. A good formulated 
request will be answered sooner. Maybe it is not a bad idea to check the Knowledge Base prior to the crea-
tion of a new request, as your question is possibly answered several times yet… 

To publish your request, click the button “GO” at the right. You will get the confirmation that your request is 
queued. An E-mail will be sent to your address as well. 

11.3 Assigning a RTS request 
Only the assigned person can answer a request. All other persons can make remarks. 
The assigned person can “pass” the request by assigning another person from the 
Assigned list. Only one person or group can be assigned.  

If you want to assign a request to another person just open the list box. Divided by a 
horizontal line, you remark in the upper part groups, persons below. Make your choice 
and click the update button. 

By declaring the access as open, you make your request public.  

You also can indicate the importance you attach on your request by choosing on a 
scale from zero to nine. 
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11.4  Creating a remark on a RTS request 

 
If you are not assigned to answer a request, but think you can contribute to its solution, just place a remark 
with it. Just open the request by clicking its number in the request list, and type your comment. Mention 
your name, date, and confirm by clicking the update button.  
 

11.5 Answering a RTS request. 

You should be assigned in order to 
answer a request in the RTS. If you 
are, you will see an answering win-
dow by opening the request. You 
open the request by clicking its num-
ber at the left of its title in the RTS 
page.  
Type your remark in the remark box 
or your answer in the solution box. 

Click respectively the Remark or the 
Solve button to confirm. 

Eventually link this solved request to 
a contact or a project. If you do so, 
confirm by clicking the return button. 

If you feel this request makes part of 
another, move it there and confirm 
with the other return button. 
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By these actions, the creator of the request gets his solution by mail, and the request itself is recorded in the 
Knowledge Base.  

To make the request invisible for others, but visible for you as assigned person, click the Stall button. You 
can view the stalled request by searching the Stall category.  

To access the Knowledge Base, open the RTS page by clicking RTS on the menu bar, click on the hyperlink 
“New Request” and click on the “Search the knowledge base” hyperlink. 
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12 Mails 
The application is linked with the mail system on your computer and network. It does not replace it, it coop-
erates with it by requesting to send for it E-mails. By using the application, you get your incoming mails in 
the usual place (inbox).  

 

To open the Mail page, click the Mail tab on the 
menu bar.  

If you want to send the same mail to several per-
sons, hold the CTRL key down when selecting in the 
list boxes. 

You are still able to add an extra address by typing 
it in the field Additional Address. 

You can use the profiles to send a mail to a defined 
group of persons. Profiles are created in Options.  

By marking the checkbox “Send Single Mails”, each 
addressee will get his separate mail. 

You can attach a file to your mail by using the field 
Attachment. 

Confirm your choices by clicking the return button  

( ).  

Look for a copy of what you sent in the Sent Items 
box of your mail Client (e.g. Outlook or Eudora. 
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13 Setting up Options 
To set up options click the Options tab in the menu bar. 

Depending of your status, you can use several options: 

• Password change 

• Bookmarks: creating URL’s to your favourite Intranet or Internet sites. 

• Delete Forum Threads: only yours, of course 

• Profiles: create, edit or delete profiles 

• List of Resources: create it needs the admin status 

• Show bookings: shows the reservation of resources per person 

• Voting formula: withdraw your vote or create one yourself. 

 

 

13.1 Change Password 
To renew your password, just type the actual one and fill in two times the new one. Use only the characters 
mentioned.  

Confirm your action by clicking the 

return button. ( ) 

 
You can change your password as 
many times as you like. If you forgot 
you password or if you are not sure, 
you are the only one to know it, ask 
your administrator a new one. Change 
it immediately, in order to have a pass-
word only known by you.   

 

13.2 Bookmarks 
Bookmarks (URL’s to Internet and Intranet locations) can be viewed in the right pane of your calendar. You 
can ask for the complete list of your bookmarks, you can create a new one, but you cannot delete book-
marks in your calendar. 
 

To delete a bookmark go to the Options page, where 
you will find the other bookmark options as well.  
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13.3 Delete Forum threads 

In order to delete your own threads without comments 
of a forum, go to the options page. Make your choice 
from the list box and click the Delete button. The sys-
tem will ask for your confirmation.  
 
 
 
 

13.4 Profiles 
A profile is the list of a group of persons, addressed by one name in order to act for all the members once in 
the same way, e.g. to send the same mail. Profiles are very efficient and time saving. To create a profile 
click the Options tab in the menu bar, click the Create button under Profiles, and complete the Profile form.  
 

Give a name for your profile in the Description box in five 
characters, and check the names of the members of this 
group. You only get the list of the member of your group. 

Finish your work by clicking the GO button.  

The system will confirm the creation, but be aware that 
the new profile will only be effective after an update of 
the memory. To update the memory use the F5 key or 
click on another menu tab, e.g. Calendar. 

 
 

 

 

 

 

13.5 List of resources 

You can view the list of booked resources of the run-
ning day in the left pane of your calendar. To view the 
complete list of resources you should go the Options 
page. 

Click the View button under “List of Resources” to get 
the list, which you can print out, or export as a CSV file 
by clicking the respective hyperlink.  

Only administrators can create new resources 
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person or a text, and click the Show 
utton. 

 

sults of the vot-

 
e right panel of their calendar. 

 the 
dio buttons of his choice. 

d by 
licking the hyperlink “List”. 

elete button 
above the question. 

 

13.6 Show bookings 
You can view the resource bookings of the run-
ning day in the left pane of your calendar. In 
order to view the complete list of bookings, 
open the Options page in the menu bar, look 
for Show bookings, choose the name of the 
booking 
b
 
 

13.7 Voting Formula 
You can make your vote on the right panel of your calendar. There you also can view the re
ing of the other members of your group. To view these results, click on the hyperlink “List”. 
To create a vote, open the Options page on the menu bar, en find the Voting Formula form. 

 
In the Voting form create the 
question, indicate whether voters 
can only give one or several al-
ternatives, and check the mem-
bers of your group you would like 
to vote. Use a profile if neces-
sary. They will see the question 
and the alternative answers on
th
 
If allowed to indicate several 
alternatives, the voter will hold 
the CTRL key while clicking
ra
 
Once voted, this question will 
disappear from the calendar, but 
the results still can be viewe
c
 
Once voted, you still can with-
draw your vote in the Options 
page. Just click the d
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14 Help 
You can get help on the application several ways.  

• The names of forms in blue are hyper-
links, taking you in a separate window 
to a help file in the language of login. 

• You can find a list of help pages by 
clicking the question mark (?) in the 
menu bar. 

• You can download this manual in the 
File page of the menu bar, both in 
Word and in PDF format, in several 
languages. If you read the manual on 
screen, you can jump from each hyper-
link to the linked text by using CTRL + 
Click in Word, or click in the left panel 
in Adobe Acrobat.   

• Use the RTS tab on the menu bar to 
put a direct question about the applica-
tion. 

• Open a new thread in the Forum if you 
think the problem or your question 
might be interesting several people. 

• Mail to the person who you think might 
help you. Put a screenshot as attach-
ment. To make a screenshot, just click 
the Prt Scr (Print Screen) key of the 
specific screen, and position your 
mouse in an empty page of your word 
processor and click CTRL + V, or use 
another technique to paste. Save the 
document, and put it as an attachment 
to your mail. 
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15 Copyright note 
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16 Admin: administration  
Administrators have sole access to some parameters to which the other users do not.  

Administrators are created by the super-administrator. Super administrator is created by the installation of 
the application on your computer system. 

A SQL database should be installed on your computer system prior to the installation of the application. 

Administrators will find an extra help page under the admin tab of the menu bar. 
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	USERS MANUAL
	OF EQUAL TCA 866’s �COMMUNICATI0N AND CONTROLLIN�
	Version 1.4 UK of 19/8/02
	Welcome!
	If you are reading this document in Acrobat (PDF) format, we suggest you to open the bookmarks in a separate window. Just click the icon as indicated to do so, if relevant:
	You can navigate through the different parts of this manual by clicking the desired part in the left window.
	If you cannot read PDF-files, you need some software (Acrobat reader). You can download it free on this site:  http://www.adobe.com/products/acrobat/readstep2.html
	To get more help on the CCT application, read chapter 14: help
	Preface
	CCT (Communications and Controlling Tool) is an application joining the partners of the European project EQUAL, TCA 866 together by the Internet. Participants can be organised in groups. Several password-controlled accesses are possible, with specific 
	Calendar: Can be accessed by different groups and persons
	Contacts: With the possibility to import, data from popular applications as Outlook (express)
	Forum: With erase possibilities for each participant
	Files (up and download)
	Projects: With filter possibilities, statistics and timeline
	Timecard: Making it easy to administer budgets
	Notes
	RTS (Request Tracking System) with a knowledge base linked
	Mail: Attachments and listing made possible
	Options: To adapt settings of the application
	? (Help): More explanations for newbies
	© Copyright: credits to who deserves
	>>: quit the application
	Admin: Administrators only. Possibility to create users and change settings.
	Starting, Closing
	Before starting the application, make sure that you are connected to the Internet. Your login and password, which your administrator gave you, are requested. Make sure you are not mixing upper and lower case: John, john, JohN and jOHN are different passw
	Click on the tab “Options” in the menu bar if you
	Always change your password after your first login.
	If you succeeded to log in, the system brings you to the calendar page. Remark the horizontal bar with tabs at the top of it. This bar is the menu system of CCT. Each tab opens a menu page with forms and data.
	Just click the Close tab to close the application. All your data are stored on a central computer. That way you can access them from every location that connected to the Internet. After logging out, you will see the login screen again, with a multilingua
	GUI (Graphical User Interface)
	After you logged in successfully, the calendar page opens. A small pop-up window will remind your appointments of the day.
	�
	At the top of the application window, remark the address field of your browser. The URL to reach the application is
	http://www.syntra-ab.be/equal/cct/index.php
	Newbies can try out the application without harm on the address
	http://www.syntra-ab.be/equal/project/index.php
	At the far right of the menu bar, at the right of the Close tab, you will see to which group your login belongs (SYNTR in this example). If you are member of several groups, you can select another group by clicking the arrow�. If you are an administrat
	The system distinguishes competences as follows:
	Users are able to view events from other group members, but not the text of those events
	Chefs are able to write events into other calendars, additionally they can create statistics and projects
	Administrators have access to the admin section. They can create new users, change passwords, etc. Administrators have all those rights only in the group to which they belong.
	Calendar
	After your login, the system automatically shows up the Calendar window. If you are in another part of the application, just click the tab Calendar to get there.
	�
	Remark the three vertical panels of the calendar:
	The left panel consist of the calendar and a form to create single events. The results pop up in the middle pane.
	The middle pane lists the events of the day. You can view them individually or as a group view.
	Several utilities are grouped in the right pane:
	RTS requests dedicated to you
	Your TODO-list
	Notes
	Bookmarks
	Projects
	Pending votes
	The left Calendar pane
	Booking your activities on the timecard.


	Above the calendar, you will find a button bar commanding the timecard. The first red button registers your starting time; the last red button registers your ending time. Register your breaks and interruptions with the blue buttons. Check the name of the
	You can make the registrations in the timecard itself. Click on the tab Timecard of the menu bar to reach the form.
	
	
	Registering the start of your activities (red button at the left).



	Click the first red button to open the registering form, then click the Submit button to register your begin time in your timecard.
	To check registered times, click the tab Timecard of the menu bar.
	Use the hyperlinks “Print” or “export CSV-list” t
	
	
	Registering breaks and interruptions (blue buttons)



	Click the left blue button to pause the registration of your working time until you click the second blue button. You can use this buttons for breaks, interruptions or Out of Offices. You only can interrupt your work once a day.
	To see the results of your clicking, open the timecard by clicking Timecard tab in the menu bar.
	Do not forget to click the submit button to confirm your action.
	
	
	Booking your end of activities (red button at the right)



	You can register your end of activities by clicking the right red button above your calendar. Do not forget to click the submit button to confirm your action.
	To see the results of your clicking, open the timecard by clicking Timecard tab in the menu bar.
	You cannot give more than one begin or end time. Use the blue buttons to indicate breaks or interruptions in your working time
	
	Calendar


	Within de calendar, which opens in the current month, you will find the day of the month of your computer clock indicated in red. Month and year are in the utmost line, left and right of it arrows to go up and down the row of months. Always confirm chang
	You will find the week numbers left of Monday. Week 1 is the week with the first labour day of the year in it.
	
	
	Resource list



	By clicking the hyperlink “Resource List”, you ge
	You can book resources while creating an appointed in the extended mode. Only administrators can create resources.
	
	
	Event List



	By clicking the hyperlink “Event List”, the appli
	With the Search function, you can indicate a word in text, note or remark to retrieve some events.
	By checking the checkbox “Entire List”, you will 
	The red quadrangle in front of de date indicates that you can delete this event. Click on it to do so.
	By clicking the +sign behind Group View, you can view several calendars of persons of your group. To view the list of calendars belonging to other groups, change the group in list box situated in the upper right corner of the application window.
	You can select a profile of calendars in order to remember the list of calendars you often want to show up. Create profiles in the module Options, which you reach by clicking the Option tab in the menu bar.
	With the time axis and the time interval, you can manipulate the way you want to view these calendars.
	View the grouped calendars in the middle pane. They only include the current month. You can change this month by changing the date in the calendar itself.
	
	Create and delete events.


	In order to create an event the quick way, use th
	If you want more data for your event, click the h
	Visibility: normal, Personal (only you), or Public
	Resource: you can select one only.
	Contact: you can select one only.
	Project: you can select one only.
	Remark
	Multiple events: once, daily, weekly, monthly or yearly with or without end date.
	Do not forget to confirm your entries with the Create button. Click the Delete button to delete.
	
	Searching


	In order to find events, type the string to search on. Next, select the modules to search in. Do not forget to confirm your action with the return (�).
	The results list contains a hyperlink for each found event. Just click on it to view it.
	Middle pane of Calendar

	This pane shows the data you asked for. In the utmost line, you will find the date, the name of the logged person and the name of his/her organisation.
	In order to create a new event, just click on the
	At the bottom left, remark the hyperlink “Print”.
	To edit an event, click on the blue text of it. The event appears in the middle pane. Choose for clicking on the Modify button to register your changes, on the Delete button to delete this event.
	Click on the hyperlink “Back” to return to the fo
	Right pane of Calendar

	The pane of the Calendar page groups several utilities, listed in this table:
	�
	RTS \(Request Tracking System\): list of reque�
	TODO-list: list of your to-dos imposed by yourself or imposed by members of your group. Create a to-do for yourself or for a member of your group by choosing a name code from the list box and typing in the field box at the left of this list. Click the Re
	Notes: List of the notes that you created.
	Bookmarks: list of your URL links. Click on “New”
	Projects: list of projects in which you are invol
	Votes: Not yet responded votes. Click the hyperli
	Answer the vote by clicking near your choice. If several alternatives are permitted, hold the CTRL-key down while clicking. Do not forget to confirm your action by clicking the return button.
	Look for more explanations of these utilities:
	RTS (Request Tracking System)
	Notes
	Bookmarks
	Projects
	Contacts
	View the Contacts page by clicking the Contact ta
	Only the administrator of a group can create memb
	To move from one field to the other, use TAB, to move backwards, use SHIFT + TAB. Do not use the return key.
	By dedicating some contacts to a category \(e.g.
	Mark the checkbox “Open to all”, if you would lik
	To create your new contact, click the Create button, to delete it, click the Delete button.
	You can put any information in the Comment box. Put some keywords in this box, which can facilitate your search operations.
	
	Importing Contacts


	You will probably own electronic lists of contacts in vCard, Outlook, Outlook Express or in some other format. You can import these by making an export file in the original application (e.g. Outlook) in CSV format (Comma Separated Value). Use the Win
	Maybe you will have to adjust the fields. Your CSV-file should contain these fields, in the same order:
	title, first name, family name, company, email, email 2, phone 1, phone 2, fax, mobile phone, street, zip code, city, country, state, category, remark, web address.
	Make empty columns (in a spreadsheet like Excel) for the fields you do not have in your contacts
	Import the CSV-file in CCT. Choose “Import” on th
	Indicate where the CSV-file can be found.
	Eventually indicate a category to filter on.
	Check the checkbox “Open to All” if you want thes
	After a successful import, you should get something like this:
	�
	A small green quadrangle indicates a personal contact, invisible to others.
	A small blue quadrangle hides the second phone number, the mobile number and second mail address if any. Just hold the mouse indicator over the quadrangle to see these data (hoover).
	The name is a hyperlink to the form. If you are the creator of it, you can edit it to modify or delete it.
	To open the mail module, just click on a mail address in the contacts. A new mail form is opened, with your contact as addressee.
	You can find a contact by choosing a field for the search operation. Do not forget to confirm your action by clicking the return button (�).
	Forum
	To open the Forum page, just click the Forum tab in the menu bar. You can only watch the Forum which is dedicated to your own group. If you are member of several groups, first change of group in the list at the right of the menu bar, and open Forum after
	In the upper line, you can filter contributions to the forum on text or name of the contributor.
	�
	The title of the contribution is a hyperlink. Just click on it to open the whole contribution.
	At the bottom, the hyperlinks “Print” and “Back” 
	To contribute as an answer to an existing one, just type your text in the white box and click the Post button. Your contribution will be preceded by "RE: " (Return) and show indented forming a thread.
	Files (archives)
	You will find the File page by clicking the File tab in the menu bar. From there on you can upload or download files to the system.
	�
	The meaning of the coloured quadrangles is as follows:
	Red indicates that you can delete this file from the server;
	Blue indicates that you are allowed to make changes;
	Green indicates that this file is for your eyes only (personal)
	Just click on the coloured quadrangle to activate it. Hoover on it to see its meaning.
	After clicking the "New" hyperlink, you open the form File Management.
	Enter the filename and path to the file you want to copy to the server, or activate the button at the right of it to search for it.
	You can encrypt the file with a password, which is needed in order to be able to read or download it from the server.
	Indicate a new category in the field Category, or indicate an existing one in the field at the right of it.
	Make your choice for the access possibilities. Choose the "Me" check box if you want it Personal, "All" if you want everybody to be able to view the file (and download it). Choose a profile if you want a group to see it. Choose "Some" to indicate manua
	The text you type in the Comment box will be repeated in the File page.
	Finally click the Go button if you are satisfied with your choices and the Back button if you are not.
	Projects
	To open the Project page, just click the Project tab in the menu bar. Projects are linked to timecards. That way you can dedicate the working time of persons or budgets to projects. Only administrators and chiefs can create and edit projects. Only the pr
	In the upper line, to select projects for searchi
	In order to view the subprojects from the list, just click the + sign, close by clicking the minus sign.
	�
	To open a project, click on the hyperlink with its name. If you cannot you are not allowed. Project assistants and visitors only can view the title and some data
	�
	Watch your dates: they should be in the format YYYY-MM-DD in order to get a chronological listing.
	From this form, you can create subprojects by cli
	Creating a project

	You need to be an Administrator or Chief in order to be able to create projects. If you have this status for several groups, first indicate in which group you want to create a project. Just choose the group from the list box at the right of the menu bar.
	To create a new project, just click the “New” hyp
	In the field “Name of the Project”, the name you 
	With the content of the field Category, you will be able to make selections in your search options. If you do not want a category for this project, leave the list box empty.
	Watch the date format in the “Begin” and “End” fi
	You can indicate whether this project is part of 
	The Leader of the project is not necessarily Administrator or Chief, but (s)he must be member of the group. To make a new group member, you should be Administrator.
	The hourly rate is expressed in Euros. So is the budget. You cannot change this, even not with the settings in the configuration of your computer.
	You can specify the priority of the project in nine degrees.
	Indicate at the right who is participating in the project. Only group members can be selected. If your project is important, you can ask your administrator to create a group for the project. In order to select several participants, hold down the CTRL key
	Project Statistics

	In order to follow up projects, you can view stat
	In the left pane of the Statistics window, you can select projects per person and per dates. Confirm your action by clicking the return button (�).
	The result is shown in the right pane:
	Timeline of Projects

	In order to view a simplified Gantt chart of \(a
	In the up most line, you can indicate the period of the timeline expressed in months. You can also select whether or not you want to see the subprojects. Confirm your choice by clicking the return button (�).
	Timecard
	To view and edit timecards, click on the Timecard
	The Timecard window presents as follows:
	You can enter records afterwards, but notice that your chief will get a copy by mail.
	To assign your time to projects, just fill in the amount of hours and minutes per project. Within the Project window (statistics), you can check the total amount, or the amount of time per person.
	You can export these figures to a CSV file. Most 
	If you want a detailed view of your time, just ma
	Deleting a time record

	�
	Only the time records followed by a red quadrangle can be deleted. Just click on it to do so. Confirm in the pop up window.
	To edit a record in order to change them, you should first delete and create a new one. Your chief will get a notice of this changes by mail.
	
	Create a new time record after date


	Use the Calendar to record your times. See Calendar.
	If you want to record times on another day, you have to pass through the Timecard page, which you access by clicking the timecard tab on the menu bar. Choose the right day, and eventually correct the month in the right pane. Bring in begin- and end break
	You should fill in the time as XXXX without “:” b
	
	Assigning time to projects


	De timecard sums the time passed per day. If you want to split up this time on one or more projects, use the left pane of the timecard.
	Select the day under “Assigning Projects” and con
	Select per project the time in hours and minutes, and click the return button to confirm. You only can see the projects in which you are involved on the selected day.
	By assigning too much time, the unassigned time turns into red.
	If you checked “Show Bookings” in the up most lin
	�
	Notes
	To open the Notes page, click the Notes tab in the menu bar. Consider notes as appendixes of projects and contacts in most of the cases, or as stand-alone documents.
	The “Open to All” notes can be viewed in the righ
	Contact Notes or Project Notes are situated in their respective pages, with the possibility to create them there as well.
	�
	De Notes page is vertically divided in two panes. The left pane to edit Title and text, the right one to list them.
	Notes can be public or personal. Public means: all the members of the group to which the login belongs.
	Personal notes are marked with a green quadrangle.
	A red quadrangle indicates the possibility to delete this note. You only can delete your own notes, the red sings thus marks all your own notes.
	When hovering the blue quadrangle, you should be able to read the first words of the hovered note.
	To open a note, just click on the title of it.
	Creating a Contact Note

	In order to create a contact note, first open the Contact page by clicking the Contact tab in the menu bar.
	Click name of the contact on which you wish to link the new note. The contact form is opened.
	In the Contact form, click the hyperlink “Notes -
	Make your note and confirm your action with the return button.
	You also can start in the Notes page, and indicate the contact in the lower left corner.
	The new note will be listed as first in the Notes list.
	By opening the contact on which the note is linked, you will remark the list of notes linked to that contact. You can open the note from there by clicking the title.
	Creating a Project Note

	In order to create a project note, first open the Project page by clicking the Project tab in the menu bar.
	Click name of the project on which you wish to link the new note. The project form is opened.
	In the project form, click the hyperlink “Notes -
	Make your note and confirm your action with the return button.
	You also can start in the Notes page, and indicate the project in the lower left corner. Confirm your action with the return button (�)
	�
	The new note will be listed first in the Notes list.
	Creating a new Note in the Notes page.

	Notes can be created in the Notes page as well. To access the Notes page, click on the Notes tab in the menu bar.
	�
	The title will be listed as hyperlink at the right. If you want to link your note to a contact and/or a project, make your choice in the list boxes under the input box under the title.
	As you will be able to perform search actions on the text in the input box, put some keywords or references in it in order to facilitate your later searches.
	The list boxes Contact and Project only admit one and only selection each. The Project list boxes lists projects and subprojects.
	By marking the checkbox “Open to all”, you make t
	Confirm your action with the return button (�)
	RTS (Request Tracking System)
	The Request Tracking System, also called ‘'troubl
	Everybody can use RTS to ask questions, consult data, make remarks and give answers.
	Opening a request in RTS

	To open the RTS page just click the tab RTS in the menu bar. The page opens with a list of pending questions:
	�
	To open a request, just click the number at the left of it. These are unique identification numbers, which are communicated by mail to the creator of the request.
	In the status column you can see in which faze the request belongs.
	De column Ass. (Assigned to) shows the code of the person to whom the request is directed by its creation. This can be updated later on. This person will see the request in his calendar (right pane
	How the form shows up, depends of who opened it: the assigned or another person:
	Opened by not-assigned person:
	�
	Opened by assigned person:
	�
	Everybody can give comments on a RTS, only the assign person can answer it. However, the assigned person can be changed by the originally assigned person.
	Creating a RTS

	The right place to start the creation of a RTS is the RTS tab in the menu bar.
	Click on the Hyperlink “New Request” in the up mo
	�
	Check the indicated mail address. The answer of your request will be sent to that address.
	Above the form, the button “Show Queue” offers th
	Be as specific as possible when typing the title as later on searches can be made on it. A good formulated request will be answered sooner. Maybe it is not a bad idea to check the Knowledge Base prior to the creation of a new request, as your question is
	To publish your request, click the button “GO” at
	Assigning a RTS request

	Only the assigned person can answer a request. Al
	If you want to assign a request to another person just open the list box. Divided by a horizontal line, you remark in the upper part groups, persons below. Make your choice and click the update button.
	By declaring the access as open, you make your request public.
	You also can indicate the importance you attach on your request by choosing on a scale from zero to nine.
	Creating a remark on a RTS request

	If you are not assigned to answer a request, but think you can contribute to its solution, just place a remark with it. Just open the request by clicking its number in the request list, and type your comment. Mention your name, date, and confirm by click
	Answering a RTS request.

	You should be assigned in order to answer a request in the RTS. If you are, you will see an answering window by opening the request. You open the request by clicking its number at the left of its title in the RTS page.
	Type your remark in the remark box or your answer in the solution box.
	Click respectively the Remark or the Solve button to confirm.
	Eventually link this solved request to a contact or a project. If you do so, confirm by clicking the return button.
	If you feel this request makes part of another, move it there and confirm with the other return button.
	By these actions, the creator of the request gets his solution by mail, and the request itself is recorded in the Knowledge Base.
	To make the request invisible for others, but visible for you as assigned person, click the Stall button. You can view the stalled request by searching the Stall category.
	To access the Knowledge Base, open the RTS page b
	Mails
	The application is linked with the mail system on your computer and network. It does not replace it, it cooperates with it by requesting to send for it E-mails. By using the application, you get your incoming mails in the usual place (inbox).
	To open the Mail page, click the Mail tab on the menu bar.
	If you want to send the same mail to several persons, hold the CTRL key down when selecting in the list boxes.
	You are still able to add an extra address by typing it in the field Additional Address.
	You can use the profiles to send a mail to a defined group of persons. Profiles are created in Options.
	By marking the checkbox “Send Single Mails”, each
	You can attach a file to your mail by using the field Attachment.
	Confirm your choices by clicking the return button  (�).
	Look for a copy of what you sent in the Sent Items box of your mail Client (e.g. Outlook or Eudora.
	Setting up Options
	To set up options click the Options tab in the menu bar.
	Depending of your status, you can use several options:
	Password change
	Bookmarks: creating URL’s to your favourite Intra
	Delete Forum Threads: only yours, of course
	Profiles: create, edit or delete profiles
	List of Resources: create it needs the admin status
	Show bookings: shows the reservation of resources per person
	Voting formula: withdraw your vote or create one yourself.
	Change Password

	To renew your password, just type the actual one and fill in two times the new one. Use only the characters mentioned.
	Confirm your action by clicking the return button. (�)
	You can change your password as many times as you like. If you forgot you password or if you are not sure, you are the only one to know it, ask your administrator a new one. Change it immediately, in order to have a password only known by you.
	Bookmarks

	Bookmarks \(URL’s to Internet and Intranet locat
	To delete a bookmark go to the Options page, where you will find the other bookmark options as well.
	Delete Forum threads

	In order to delete your own threads without comments of a forum, go to the options page. Make your choice from the list box and click the Delete button. The system will ask for your confirmation.
	Profiles

	A profile is the list of a group of persons, addressed by one name in order to act for all the members once in the same way, e.g. to send the same mail. Profiles are very efficient and time saving. To create a profile click the Options tab in the menu ba
	Give a name for your profile in the Description box in five characters, and check the names of the members of this group. You only get the list of the member of your group.
	Finish your work by clicking the GO button.
	The system will confirm the creation, but be aware that the new profile will only be effective after an update of the memory. To update the memory use the F5 key or click on another menu tab, e.g. Calendar.
	List of resources

	You can view the list of booked resources of the running day in the left pane of your calendar. To view the complete list of resources you should go the Options page.
	Click the View button under “List of Resources” t
	Only administrators can create new resources
	Show bookings

	You can view the resource bookings of the running day in the left pane of your calendar. In order to view the complete list of bookings, open the Options page in the menu bar, look for Show bookings, choose the name of the booking person or a text, and c
	Voting Formula

	You can make your vote on the right panel of your
	To create a vote, open the Options page on the menu bar, en find the Voting Formula form.
	In the Voting form create the question, indicate whether voters can only give one or several alternatives, and check the members of your group you would like to vote. Use a profile if necessary. They will see the question and the alternative answers on t
	If allowed to indicate several alternatives, the voter will hold the CTRL key while clicking the radio buttons of his choice.
	Once voted, this question will disappear from the
	Once voted, you still can withdraw your vote in the Options page. Just click the delete button above the question.
	Help
	You can get help on the application several ways.
	The names of forms in blue are hyperlinks, taking you in a separate window to a help file in the language of login.
	You can find a list of help pages by clicking the question mark (?) in the menu bar.
	You can download this manual in the File page of the menu bar, both in Word and in PDF format, in several languages. If you read the manual on screen, you can jump from each hyperlink to the linked text by using CTRL + Click in Word, or click in the left
	Use the RTS tab on the menu bar to put a direct question about the application.
	Open a new thread in the Forum if you think the problem or your question might be interesting several people.
	Mail to the person who you think might help you. Put a screenshot as attachment. To make a screenshot, just click the Prt Scr (Print Screen) key of the specific screen, and position your mouse in an empty page of your word processor and click CTRL + V,
	Copyright note
	��
	Admin: administration
	Administrators have sole access to some parameters to which the other users do not.
	Administrators are created by the super-administrator. Super administrator is created by the installation of the application on your computer system.
	A SQL database should be installed on your computer system prior to the installation of the application.
	Administrators will find an extra help page under the admin tab of the menu bar.

